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This document summarizes the following.
1. What’s BLDC control.
2. Introduction of Infineon iMOTION products
3. Motor control by Infineon iMOTION
4. Motor drive experiment
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Advantages of BLDC motor

BLDC features

Comparison with 
other motors

Power 
efficiency

○ 90% or more high 
efficiency

noise ○ small

Variable 
speed 
range

○ wide

response × T.B.D.

life ○ Long life

price × Fair to expensive

Application 
examples

Air conditioner
Dishwasher

Washing machine
Refrigerator

Ventilation fan
Small home appliances

Advantages of BLDC
Explains how to achieve high 

efficiency and low noise

Disadvantages of BLDC
And how to improve 

responsiveness

"BLDC = Brush Less DC motor"
Since there is no electrode brush, electrode wear is eliminated, and the mechanical life of 
the motor is greatly extended.
Furthermore, it is possible to increase power efficiency and run the motor with low noise.

In order to realize it,
・ Control circuit (hardware)

・ Algorithm (Software)
should be optimized
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BLDC motor control

To run BLDC motor smoothly
1) It is necessary to synchronize with the rotor rotation position and
2) To supply current to the coil with good timing.

2) Drive method for passing current to coil
1. Apply rectangular wave current (120 degree conduction)
2. Apply sinusoidal current (180 degree current)

1) How to know the rotor rotation position
1. Measure the position using a magnetic sensor, etc., and identify the rotor position
2. Measure motor current and estimate rotor position (sensorless)

For cost reduction,  and low noise and vibration
 Sensorless without magnetic sensor
 Sine-wave drive (180 degree conduction)
are the trend.

←Trend

←Trend
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Introduction of Infineon iMOTION

At Infineon,
We release IC for BLDC motor control.
That is the iMOTION series.
By using iMOTION IC, BLDC control by sine wave drive with sensorless is possible.

iMOTION IMC100 High performance motor control IC series
Infineon-IMC100_iMOTION-ProductBrief-v01_00-EN.pdf
https://www.infineon.com/dgdl/Infineon-IMC100_iMOTION-ProductBrief-v01_00-
EN.pdf?fileId=5546d46261764359016198ba6329153f
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Introduction of Infineon iMOTION

iMOTION IMC100 High performance motor control IC series
Infineon-IMC100_iMOTION-ProductBrief-v01_00-EN.pdf
https://www.infineon.com/dgdl/Infineon-IMC100_iMOTION-ProductBrief-v01_00-
EN.pdf?fileId=5546d46261764359016198ba6329153f

The advantage of iMOTION is
"Various speed drive solution ready for use"

(As shown on the right)
No programming like a microcomputer is required, 
and since the ADC and comparator required for motor control 
are embedded, the control board can be realized with a 
minimum number of components.

Infineon’s Website
https://www.infineon.com/cms/en/product/power/motor-control-ics/digital-motor-controller-imotion/

provides technical information such as evaluation boards and 
power element selection guides in addition to iMOTION product 
information.



N
E

X
T

Y
 E

le
ct

ro
ni

cs
 C

o
n

fid
e

nt
ia

l

Copyright © NEXTY Electronics Corporation

6

BLDC control by iMOTION

Sensorless motor drive block diagram

BLDC Motor
No position 
sensor required

Current sensor

This page introduces how to rotate BLDC without sensor using iMOTION.
The circuit image is as shown in the schematic diagram below.

iMOTION IC IMC101T

3 phase 
inverter

Gate driver

iMOTION IMC100データシート v1.3 2019-02-14
Infineon-IMC100-DS-v01_03-EN.pdf
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iMOTION Introduction Guide

■Controller IC IMC101T-T03
Eval-M1-101T (2018-01-23)
Equipped with USB debugging function

■Power board
EVAL-M1-05-84D
IRSM505-084
Input: AC 90-140V / DC 45-200V
20-150W sensorless 3-phase motor

【Purpose】
Use Infineon's evaluation board to run the motor.
Travel time is about 1 hour.

【procedure】
1. Install iMOTION software tools
2. Hardware connection: Use the following two evaluation boards
3. Set the system and motor configuration with “MCEWizard”
4. IC parameter setting and motor rotation with "MCEDesigner"
5. Repeat 3.⇔4. for motor control parameter tuning

IPM (Intelligent Power Module)
Gate driver and MOSFET in 
one package

There is a brief explanation 
on the next page

7
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iMOTION Motor Tuning Tool

iMOTION has released two softwares as motor tuning tools.

1. Enter the parameters required for MCEWizard motor control
Motor characteristics
Control board constants (RC parameters)
Motor rotation specification
Fail safe setting
Script function settings

2. MCEDesigner Motor driving experiment and state observation
Use the debugger (iMOTION LINK)
Writing parameter/firmware/script files to IC
Writing and reading of detailed register values   of IC
Understanding motor drive status
FOC control loop status recording and graph display

If you have not yet installed the software tools, 
please follow the instructions on the next page.

8
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Software installation

Install the iMOTION software tools.

<<https://www.infineon.com/cms/en/product/power/motor-control-ics/digital-motor-controller-imotion/>>
Click "MCEDesigner v2.2" and "MCEWizard v2.2" to download.
If you have the latest version, please install it.

The latest version is v2.2. (February 3, 2020)

9
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Software installation

After downloading, check the file size of the executable file 
(confirm whether the download was successful), and then execute the installation.

MCEWizard installation screen MCEDesigner installation screen

10
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Software installation

During the installation, security software may be checked.
It may be due to "unknown publisher".
At this time, files are downloaded from the official Infineon website, 
so assuming there is no problem and installation is continued.

11
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Software installation

After the installation is completed, 
an “iMotion2.0” folder is created in the Windows Start menu.

Run MCEDesigner

This completes the software tool installation

How to use MCEWizard

Script Function Manual

How to use MCEDesigner

Run MCEWizard

Script sample collection

12
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Hardware preparation

■Low side resistance of DC-BUS voltage sensing
At power board initial setting, DC Sense low side resistor R14 is not mounted (DNI).
Instead, R1 = 13.3kΩ is mounted on the controller board.

■Main power supply
Both AC and DC power supply can be used. The connection of the J1 connector is as shown in Table 5 below.
(This time, experiment is done with AC100V)

Power Board Controller board

DNI

13
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Hardware preparation

■Shunt configuration and resistance
At the beginning of Power Board, Leg shunt (3 shunts) is mounted.
The resistance value is R250 (250mΩ).

It can be converted to a single shunt.
The remodeling procedure is described in the manual,

1) RS1 and RS3 have to be removed 
2) IU+,IV+,IW+ have to be connected 
3) R7 has to be changed to 3.48 kΩ 

Leg shunt (3 shunts)

Here, proceed with the Leg shunt without modification.

14
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Hardware preparation

Make hardware connections

3 phase motor 
connector

Equipped with a debugger function.
(The debugger iMOTION LINK is not 
required)

Power connector

Connect a PC to the USB 
connector of Eval-M1-101T.
The power supply for the PC 
and the motor are insulated.

15
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Motor drive tuning

[Software setting procedure]
1. Start "MCEWizard" on your PC
2. Set the parameters of the power board and motor with "MCEWizard" and 

generate .txt (parameter file)
3. Start "MCEDesinger" on your PC
4. Write the firmware (.ldf file) to the controller IC with "MCEDesinger"
5. Write .txt (parameter file)
6. Start the motor with the "Start Motor" command
7. If it does not rotate properly, repeat steps "2, 5, and 6" = Tuning work

16
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Start "MCEWizard"

Please select Eval-M1-101T

Check here for detailed settings such as shunt 
resistance value and amplifier forward / reverse setting.
The gray item (default setting) can be changed.

Input parameters with MCE Wizard
17
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Select "Advanced Mode" from the 
pull-down menu to display the 
parameter list setting screen.

There are separate categories for 
“System” and “Motor” settings.
Switch by tab operation.

Screen layout of MCE Wizard

Input parameters with MCE Wizard
18
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In the "Option Page" 
pulldown, make sure it is 
"Leg Shunt"

Basic check items in MCE Wizard

Input parameters with MCE Wizard
19
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Motor basic settings

Motor characteristics (current, number of rotor poles, resistance, inductance, 
maximum / minimum speed) are essential.

20

Input parameters with MCE Wizard
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Parameters related to rotation 
speed

Set the rotation speed related parameters.

Input parameters with MCE Wizard
21
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(e.g.) Rotation speed specification setting

Input parameters with MCE Wizard

Motor Max RPM

Minimum Running 
Speed

Ta
rg

et
 S

pe
ed

 
se

tt
in

g 
ra

ng
e

16,3844,096RPM

100RPM 400

3,000RPM

300RPM

Re
qu

ire
d 

sp
ee

d
12,000

1,200

MCEWizard MCEDesigner

100RPM 2,000RPM

10
0%

20
%

22
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Enter the current scaling value correctly based on the resistance value of the shunt 
resistor.
Incorrect settings may cause overcurrent and damage the evaluation board. Please 
check carefully.

【Verification】

The input value is determined by the "shunt resistance" and "amplifier circuit".
The default of EVAL-M1-05-84D is
Leg shunt 250 mΩ
↓
Eval-M1-101T amplifier circuit default setting is
R6 = 10 kΩ
R7 = 2 kΩ
↓
208.3mV / A is the default value.
(250 * 10k/(10k+2k) = 208.3)

Input parameters with MCE Wizard
23
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After entering the parameters, 
select “Verify & Save Page”,

Click “Calculate” and check if the 
setting items are correct.
If all are displayed in blue, there is 
no error.

Click “Export to Designer File 
(.txt)” to output .txt.

Save the setting file 
(extension .mc2) of "MCEWizard" 
with File-> Save Wizard File.

Validate settings input, save to file

Input parameters with MCE Wizard
24
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If you click “Calculate” and there are 
incorrect settings, errors will be displayed 
in red.

Adjust the parameters until the error 
disappears.

If an error occurs when validating the settings input

Input parameters with MCE Wizard
25
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Load .irc (configuration file = MCEDesigner setting file) with File-> Open 
The default settings of the device are read.

Select the .irc file of IMC101T-T038.

Drive the motor with MCE Designer
26
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After activating the “System” window (the menu structure will be different if the “Motor1” window is active), 
select “Preference” from the menu and set the COM port.
When it is possible to communicate with the controller IC, a green circle and 
COM port are displayed in the status line.

Drive the motor with MCE Designer
27



N
E

X
T

Y
 E

le
ct

ro
ni

cs
 C

o
n

fid
e

nt
ia

l

Copyright © NEXTY Electronics Corporation

Set file path

Drive the motor with MCE Designer

Select to write firmware 
and parameters

Tools → Programmer
Select to write the firmware and parameters to the device.

28
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Click the “Configure Motor” icon to initialize the motor.

Click the "Start Motor" icon to rotate the motor.

Up to this point, the motor will move for a moment, but it will not rotate.
The cause is insufficient tuning.

Recheck the parameters with MCE Wizard.

Drive the motor with MCE Designer
29
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If the motor does not rotate or it stops abnormally, 
check the status line of MCE Designer.

(Example) Motor stops at "Motor1 Fault"
Tips are displayed when the mouse cursor is placed.
Review the settings of MCE Wizard with Tips as a hint.

Tuning work, check-1

In the above case, the DC voltage overvoltage is detected and 
the motor is stopped abnormally.
Review the DC voltage overvoltage setting to see if it is set too low.

30
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【 Setting review example 1 】
When "GateKill" is displayed on the "Motor1 Fault" Tips display, 
the motor drive circuit is forcibly turned off due to current limitation.
Review the settings of "Current limit amount" and "Maximum/Minimum speed".

Tuning work, check-2
31
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【Setting review example 2 (Motor Back EMF Constant (Ke))】

You can observe the back electromotive force by probing between 
UVs with an oscilloscope and turning the motor.
The counter electromotive force Euv when rotated at 1000 rpm is measured, 
and Epk, Eu, and Ke are calculated.

32

Tuning work, check-3
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■Can read control register settings and values
Use "Write Registers" and "Read Registers" in the Motor window.

MCE Designer Features Tips

”Write Registers”

”Read Registers”

Normally, in motor drive tuning, MCE Wizard is 
used to set the motor parameters, and the set 
values are reloaded in MCE Designer to perform 
a motor drive experiment.
This loop of steps will be repeated.

If the above procedure loop is complicated, you 
can write the value directly to the control 
register of "Write Registers" and you can reduce 
the procedure because you do not need to 
return to MCE Wizard.

33
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■Waveform display is possible
The iMOTION internal parameter values are displayed on the waveform screen in real time.

MCE Designer Features Tips

(e.g.) Motor Target Speed (green) and Motor Speed (yellow)

34
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■User Function
You can register and execute a task process.
It can be used for motor characteristic evaluation and testing.

MCE Designer Features Tips

In the menu bar
“Configure Motor”
“Start Motor”
“Stop Motor”
The icon of is linked to 
the function on the 
right.

35
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Reference material

MCE Designer Manual : MCEDesigner Users Guide.pdf
Script function manual :Script For MCE 2.0 User Guide.pdf

Reference Manual List

EVAL-M1-05-84D Application note, schematic
https://www.infineon.com/cms/jp/product/evaluation-boards/EVAL-M1-05-84D/productType.html?productType=5546d46253f6505701544c6f6143172b

EVAL-M1-101T Data sheet
https://www.infineon.com/cms/jp/product/evaluation-boards/eval-m1-101t/

36



N
E

X
T

Y
 E

le
ct

ro
ni

cs
 C

o
n

fid
e

nt
ia

l

Copyright © NEXTY Electronics Corporation

Motor experiment example

1. Adjustment of motor current waveform
2. Adjustment of rotation rise time
3. Change of rotation speed
4. Speed and power supply current
5. Noise adjustment

37
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[Experiment] Motor current waveform adjustment

■ Adjustment tips
Flx_M is flat and 2,048 is the best value.
In the measurement below, it is flat and around 
1,350
While adjusting the Flux Estimator Time 
Constant, find a setting where Flx_M is stable.

■ Adjustment tips
Gating Propagation Delay
Phase Shift Window Size
While adjusting (current sampling timing), 
search for a setting that improves the 
motor current waveform.

Flx_M

Iu

Iu

Iv

38
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[Experiment] Adjusting the rotation rise time

■ Adjustment tips
Adjust the 
Speed Regulator Proportional Gain
Speed Regulator Integral Gain
Speed Ramp Rate 
so that the target speed is reached in the expected 
time while reducing overshoot.

TargetSpeed
Desired motor speed

MotorSpeed
(Motor Actual Speed)

Overshoot

Rise speed
(RPM / s, 
acceleration)

Rise time

39
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[Experiment] Change of rotation speed

TargetSpeed = 8,000
Then, rotation is stable.

The parameter settings were 
adjusted to be stable at 
TargetSpeed = 3,600.

The current waveform began to be 
disturbed from around TargetSeed
= 8,500, 
and synchronous control became 
impossible at TargetSpeed = 9,500.
It seems that the parameter setting 
at TargetSpeed = 9,500 is 
necessary.
Multiple parameters are possible by 
using the Script function.

Does not rise from 9,300

40
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[Experiment] Speed and power supply current

Observe rotation speed and current value by changing DC voltage (experiment without motor load)

750rpm

1,500rpm

3,000rpm

Reached 3,000 rpm
TargetSpeed = 12,000

DC voltage 140.5V DC setting 240V

Increase DC voltage

linearly change

41

Rotation speed and current
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[Experiment] Noise adjustment
Experiment without motor load fixed at 1,500 rpm
Only the PWM carrier frequency is changed, other parameters are fixed.
PWM carrier frequency 15kHz → 18kHz → 20kHz → 22kHz → 24kHz

■Findings
① Approximately 3dB improvement at PWM carrier frequency 15kHz vs. 24kHz (63.0dB → 59.4dB)
② When the PWM carrier frequency was raised above 20kHz, the peak noise could be shifted out of the audible range.
③ There are natural frequencies at 250Hz and 1.7kHz. This is independent of the PWM carrier frequency (presumed 

to be rotation speed and mechanical factors).

15kHz 18kHz 20kHz 22kHz 24kHz

(For noise measurement, the iPhone7 FFT Wave application is used simply)

42
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End of file


